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Before you begin
I don’t know where to start!
Well, if you are reading this document, you 

are on the right track! Start with reviewing 

this Tips & Tricks guide for technical and 

creative insights to help make the process 

a little easier. If you want further support, 

try reviewing the list of resources provided, 

or contact Marketing & Communications 

for assistance.

Are you a Mac or a PC?
The templates have been developed 

by experienced designers for use in the 

most recent versions of Microsoft Office 

for both PC and Mac. If you are working 

on a version of Microsoft Word (Word) or 

Microsoft PowerPoint (PowerPoint) that 

is not 2007 or newer, you should install all 

current updates.

For PC users: get the Microsoft 

Compatibility Pack available through the 

Microsoft site at: www.microsoft.com/en-

us/download/details.aspx?id=3 that will 

allow you to open documents created in 

later versions of Word.

For Mac users: Go to the menu bar: 

Help > Check for Updates to see if your 

software is up-to-date.

What do you want to say?
You should know what you need to say 

before selecting templates. You should 

have (at a minimum) a rough version 

of your content, including images, 

word count and contact information. 

This content will help as a reference in 

selecting a poster, brochure or screen file 

with similar content structure. 

Say more with less is the approach you 

should take when compiling your content. 

This is particularly true of posters and 

screen files, for which you may only 

have seconds to grab the attention of 

your viewer. Be brief but bold with your 

headlines and key points.

For collateral such as event programs, 

newsletters and brochures, try to organize 

your content in small, manageable 

sections with meaningful subheads. 

Be sure to take advantage of subheads, 

bullet points and quotes to highlight 

interesting or important facts. 

If you have more to say than can 

reasonably fit in the template provided — 

point your reader to a website for further 

information, instead of trying to fit more 

copy in a single layout.

How are you going to say it?
So, you have an event, program or 

organization you need to promote. 

You should identify which templates or 

combination of templates would best 

meet your needs. This will depend on a 

number of factors including the nature 

of the event, audience, content, budget 

and timing. Whether it’s a series of 

posters promoting upcoming lectures, or 

a campaign of posters, screen displays 

and a follow-up brochure for a new 

on-campus organization — you should 

consider selecting matching templates for 

maximum impact.

tips&
tricks  

Marketing Templates This handy reference outlines 
software tips and design secrets 

that will help you publish your 
Memorial University work like a pro.

Last updated: April 8, 2013

http://www.microsoft.com/en-us/download/details.aspx%3Fid%3D3
http://www.microsoft.com/en-us/download/details.aspx%3Fid%3D3
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Don’t be a rule breaker! 
Memorial’s Publication Policy states that 

all communications must be reviewed for 

appropriate visual and writing style. The 

Division of Marketing & Communications 

handles all requests for review of on-

brand materials. Before printing your 

poster — ensure you work with Marketing 

& Communications to finesse your final 

layout.

All print templates have been developed 

for standard-sized sheets — either letter 

(8.5 x 11 inches) or tabloid (11 x 17 inches ). 

Though they can be printed on any office 

printer that can accommodate those 

sheet sizes, it is always recommended to 

send a final PDF of your poster to Printing 

Services (PS) for professional printing. All 

printed communications from the university 

should be processed through PS.

So, what do we have 
here?
Microsoft Word templates
Posters
We have provided both letter- and 

tabloid-size posters in a variety of layouts 

and colours. All posters should print 

with ease on an office printer that can 

accommodate standard sheet sizes. 

Different options for organizing and 

presenting your content have been 

provided, including options with large 

photo placeholders in both horizontal and 

vertical formats, callout text, biographies, 

and longer descriptive copy. You should 

select a layout that best represents the 

amount of content you are trying to fit.

Text styles for a variety of content 

hierarchy have been provided, including 

headlines, subheads, body copy and 

contact information. Use the formatting 

provided for text whenever possible. 

If you have any concerns about how to 

modify styles, or clear formatting on text 

— look to the Text Styles section of this 

document.

Tri-fold brochures
There are four different tri-fold brochure 

templates, available in up to 30 different 

colour combinations. Some layouts 

include photo placeholders in both 

horizontal and vertical formats, and all the 

templates include a wide variety of text 

styles with appropriate font sizes, colours 

and weights applied. This document 

outlines how and when to use Text Styles 

to ensure consistency and proper colour 

application in your materials.

Each of these two-page templates should 

be printed double-sided on a standard 

letter sheet with no bleed. It should fold to 

a final size of approximately 3.67 x 8.5 inches. 

Blocks of colour and photos have been 

placed on panels to make it easy to fold 

your final brochure.

Multi-page newsletters
A two-column, three-page newsletter 

is provided as a sample, but you may 

insert as many pages as necessary. The 

first page in the layout has a primary 

masthead, while the second and third (and 

any additional pages inserted) share a 

common secondary header. Footers have 

been applied to include automatic page 

numbering. Photo placeholders, as well 

as captions, story separators and a short 

In This Issue section has been included 

for your convenience. You may include as 

many stories or sections as you like.

This newsletter may be printed as single- 

or double-sided pages and stapled; or 

emailed as a pdf.

http://www.mun.ca/policy/site/policy.php%3Fid%3D153
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Event programs
The sample layout is two pages with a 

variety of content options and styles, 

including a table of entries, biography 

section and horizontal as well as vertical 

photo placeholders. 

Output your final layout as double-sided, 

letter-sized sheet, and fold it to create a 

four-page 5.5 x 8.5 inch event program.

Certificates
Three different versions have been 

provided — certificates of thanks, 

appreciation and completion. The 

templates include fields for the recipient 

name, description of activity or course, 

and dates, as applicable.

Email signatures
Sample email signatures, including long 

and short examples, have been provided. 

These .doc files have standard font, size, 

structure and punctuation included for 

your reference. You can copy and paste 

the desired format into your preferred 

email application and substitute your 

individual contact information where 

necessary.

Microsoft PowerPoint templates
PowerPoint presentations
There are two categories of PowerPoint 

presentations provided:

The Main PowerPoint template has 

been designed for widespread use by all 

university faculty and staff for internal or 

external audiences. It is available in seven 

colour combinations, and each provides 

slide options with both dark and light 

background. There are a variety of slide 

layouts, including section starts, multi-

column content, one, two, three or four 

images on a slide, graphic and chart slides 

and text-only quote slides. 

The Pop PowerPoint template has been 

designed for a presentation with less 

content, more images and a stronger use 

of pop colours. This type of template 

would be appropriate for certain internal 

audiences or a younger demographic. 

There are eight different pop colours that 

you can combine in interesting ways to 

achieve a bold and vibrant presentation. 

There are fewer content slides, more 

full-colour, large text highlights and quote 

slides. 

To learn how to change and apply 

different options to your slide layouts 

in either the main or pop template, 

review the Slide Layouts section of this 

document.

Screen displays
We have provided PowerPoint slides 

that may be used to export screen-

ready JPGs for use across a selection of 

the university’s digital display screens 

including those operated by: Student 

Affairs & Services, Science, and Marketing 

& Communications: 1024 x 768px; 

Grenfell Campus: 1920 x 953px; QEII 

Library: 1080 x 1920px. There are more 

than 400 single screen file templates 

available in a range of layouts and colour 

options. 

The design of the screen files is consistent 

with the other templates, and can be used 

to create a campaign of materials for your 

event or organization.
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I need help with Word
Working with text
Placeholder text included in the templates 

uses the font Arial in a variety of sizes, 

colours and weights, in accordance with 

the Brand Standards. This typeface is the 

only approved font for print and screen 

marketing collateral. You should not use 

any other fonts. 

Effective page layouts are based on a 

distinctive hierarchy of text that creates 

contrast through varying the size and 

colour of type. A basic system of hierarchy 

would be: headline; subhead; body and 

call-to action. These templates use a 

similar set of base styles and additional 

styles as needed.

Most type styles have been programmed 

into the templates using Word styles. 

Word styles are accessible on both Macs 

and PCs in versions 2007 and newer.

How do I find Word styles?

To access the list of styles available in your 

template selection:

Mac Figure 1A 

1.	Reveal the Styles panel (or Formatting 

Palette)  

2.	With type highlighted or cursor active, 

find the Styles panel on the HOME 

tab of the Ribbon at the top of the 

workspace

PC Figure 1B 

1.	With type highlighted or cursor active, 

find the Styles panel on the HOME 

tab of the Ribbon at the top of the 

workspace

How do I add my own content?
The most foolproof way to import content 

into a Word template is to type your 

content over the existing pre-formatted 

text. For example highlighting and typing 

over, “Here is a multiple line headline” 

in a poster template will ensure that the 

formatting remains intact. For headlines 

or small amounts of copy this should be 

manageable. However, this approach is 

probably not efficient for longer copy such 

as that of a tri-fold brochure.

If you copy and paste content from 

another source, such as a website or a 

pdf, you may find that it will overwrite the 

styles of the templates and maintain the 

formatting from the source. Don’t panic!  

There are several ways to deal with this 

issue if it happens.

Mac

1.	Clear formatting. Under the Styles 

palette there is an option called Clear 

Formatting. Highlight the text that is 

formatted and then select this button 

or option to eliminate all unwanted 

formatting and reset it to Normal. You 

can then select the style that you want 

to apply from the list. 

2.	Paste unformatted. To paste rich text 

(text that is formatted or styled) that 

you have copied from another source, 

select the placeholder text in the 

template, and go to Edit Menu > Paste 

Unformatted.

3.	Paste special. To paste rich text (text 

that is formatted or styled) that you 

have copied from another source, 

select the placeholder text in the 

template, go to Edit Menu > Paste 

Special and choose Unformatted Text 

from the list in the pop-up window.  

http://www.mun.ca/marcomm/brand/standards
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PC 

1.	Clear formatting. Under the Styles 

palette there is an option called Clear 

Formatting. Highlight the text that is 

formatted and then select this button 

or option to eliminate all unwanted 

formatting and reset it to Normal. You 

can then select the style that you want 

to apply from the list. 

2.	Paste special. To paste rich text (text 

that is formatted or styled) that you 

have copied from another source, 

select the placeholder text in the 

template, go to the Paste palette 

in the Ribbon > Paste Special > 

Unformatted Text.

How do I format text outside of 
Styles?
We encourage you to use the 

programmed Word styles whenever 

possible. However, if the need arises to 

format your type outside of these styles, 

then here are several helpful hints to 

working with type in Word.

For Mac and PC

1.	Highlight text. To see the range of 

typographic tools available, highlight 

text or insert the cursor in your 

document. Word displays tools in the 

Ribbon based on whatever selection 

you have active in the document. If you 

have an image selected — it is unlikely 

you will see the text tools options for 

which you are looking. Highlight a text 

element, such as a sentence or word 

and watch the options change in the 

Ribbon.

2.	Access the typographic panels in 

the Ribbon. Once you have the text 

highlighted, a wide variety of type 

option panels will appear in the 

Home tab of the Ribbon. With just a 

few clicks you can format your text 

frame, alignment, paragraph spacing 

or character styling. Try these options 

and explore other tabs (such as Format 

and Layout) to learn what kind of 

typographic control you can achieve in 

Word.

3.	Right- or control-click on a text 

selection. Select Font, Paragraph or 

a number of other text menu options 

that appear in the secondary menu. 

Explore the formatting options that 

open in the pop-up window.

4.	Access the text options in menus 

(Mac-only option). Go to Format > 

Font, Paragraph or a number of other 

text menu options. Explore the options 

that open in the text formatting pop-

up window.
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Working with images
Photos, illustrations and graphics can 

help add visual interest to your template. 

We encourage you to select appropriate, 

licensed and on-brand images when 

compiling content for your marketing 

materials. 

Is my image good enough quality for 
printing?
The best images for printing have a 

resolution of 300 dots per inch (dpi)

and are CMYK colour-mode. But 

without photo-editing software, such as 

Photoshop, it may be hard to tell if your 

selected photo is of adequate quality for 

printing. Here are some guidelines for 

selecting images for your template:

1.	Use photo software:  On a PC you can 

open the image in Paint. Go to Image 

> Attributes > Resolution. On a Mac 

you can open the image in Preview > 

Tools > Show Inspector.

2.	Print a sample: A high quality image 

you should print at 300 dpi (at 100 

per cent size or smaller). However, 

images that are 220 dpi and above are 

adequate. A good way to determine if 

the quality is good enough is to print 

a sample of the document with the 

image in place. Is it sharp? 

3.	Images downloaded directly from 

websites are rarely appropriate — 

these images are 72 dpi. You often will 

get pixelated images when these are 

printed instead of displayed on screen. 

4.	File size is a good indicator of the 

quality of the image: less than 500 kb 

is likely a low-resolution image. The 

best quality images have very large 

file sizes. You probably couldn’t email 

more than a couple of them at a time.

5.	For the best images, the following 

formats are recommended: TIFF or 

EPS. The following format is exclusively 

reserved for lower resolution: GIF. 

Watch out for JPEG or PNG files, these 

can be either high- or low-resolution.

We recommend that you use the Web 

Gallery on mun.ca, to find thumbnail 

images that are appropriate. Once you 

have made your selections, you can 

request high-resolution versions from 

Marketing & Communications.

Inserting or changing a picture
Whether you are placing a new image into 

a Word document or changing an existing 

image in a template with your own on-

brand photo, there are a few different 

ways to approach these tasks.

For Mac and PC Figure 2A+B

1.	Insert image. In the Word Ribbon go 

to Insert > Picture and navigate to the 

picture file you want to insert. In the 

next section we will outline how to 

format this picture using the Picture 

formatting palette.

2.	Replace image. Click on the 

placeholder image or photo you would 

like to change. Then Right- or Control-

Click to bring up the secondary menu. 

Select Change Picture from the Menu 

and navigate to your preferred image. 

This will replace the content of the 

photo without repositioning its frame 

or altering your layout.

http://www.mun.ca/marcomm/image/photogallery.php
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Formatting a picture
You may need to make adjustments to 

your images or photos once they have 

been placed into your selected template. 

Word offers a number of formatting 

options for your images. The formatting 

tools can be accessed in the same way as 

text tools.

For Mac and PC Figure 3A+B  

1.	Format picture tab. With the picture 

selected, in the Ribbon go to Format 

(Picture: Mac or Picture Tools: PC) 

and explore the formatting options 

available through icons; including 

fills, lines, size, position, cropping and 

rotation options.

2.	Right- or control-click. Click on the 

image or photo you would like to 

format. Then right- or control-click to 

bring up the secondary menu. Select 

Format Picture from the Menu to 

launch a complete picture formatting 

window with all the formatting options 

available for that image.

Rotate an image Figure 4A+B 

From the picture formatting pane in the 

Ribbon, select the Rotation icon, and you 

can chose from a menu of pre-determined 

rotation options. To do a custom rotation, 

double-click on the image so that knobs 

appear on the corners (called nodes). At 

the top of the graphic you can see a small 

line with a green node on the end — this 

is called the Rotation Handle. If you hover 

your cursor over the green node you will 

see a rotation symbol appear. Click and 

move the mouse right or left to rotate 

your image accordingly. 

Crop an image Figure 5A+B 

From the picture formatting pane in the 

Ribbon, select the Crop icon, and you can 

chose from a menu of pre-determined 

Cropping and masking options. Practice 

with these tools to see what effects you 

can achieve. 

Resize an image Figure 6A+B 

From the picture formatting pane in the 

Ribbon, select the Size icon. Check the 

small box to ensure the image scales in 

proportion — without getting distorted. 

To do a manual scale, double-click on the 

image so that the corner nodes appear. 

Click on one of the four corner nodes 

on the image and move the mouse to 

proportionally scale the image smaller or 

larger. If you select one of the nodes on 

the sides, top or bottom you must hold 

Shift while scaling, to ensure that the 

image does not lose it proportions. 
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How to save a Word document 
as a PDF
If you plan on printing a small quantity of 

samples on your office printer, printing 

directly from Word is your best option. 

However, if you are going to send files to 

Printing Services to print a larger quantity, 

then we recommend you send a high 

quality PDF. 

There are a number of different ways to 

save your Word file as a PDF. Your solution 

depends on variables including: platform, 

version, and which updates and printers are 

installed on your local and network drives. 

If you try all of the following options and 

you still cannot save your file as a PDF, 

contact Printing Services or Marketing & 

Communcations for support.

1.	Save As Menu. If you navigate to 

File (Office icon) > Save As > you will 

find Save as PDF or Save As Adobe 

PDF. Either of these options will work 

well — but by selecting Adobe PDF, 

you will be prompted with additional 

options to customize your PDF for 

quality and size. Selecting Adobe 

PDF > High Quality Settings is 

recommended.

2.	 Printer Menu. If you do not have the 

Save As PDF option available in your 

version of Word, it is more than likely 

that you will be able to use the printer 

dialogue to generate your PDF. 

a.	Mac Figure 7A  

Go to Print > and select from the 

drop down menu in the lower left 

PDF > Save As Adobe PDF. The 

next pop-up window will allow 

you to select your PDF settings.  

Choose a meaningful name and 

save your new PDF.

b.	PC Figure 7B  

Go to Print > and select from the 

drop down menu — Adobe PDF. 

The next pop-up window will allow 

you to select your PDF settings.  

Choose a meaningful name and 

save your new PDF.
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I need help with 
PowerPoint
The PowerPoint presentation templates 

have been populated with placeholder 

text and imagery that is representative 

of an effective final presentation. You can 

choose to overwrite the existing slides 

with your own content and delete any 

unwanted slides, or insert new, blank 

layouts. 

Working with slide layouts
There are a variety of text- and image-

based content slides, as well as dark and 

light backgrounds available for each type 

of slide. 

There are several ways to build your 

presentation slides from this template:

1.	Overwrite existing template slides. 

You can delete any unwanted slides 

from the presentation (to delete slides: 

highlight the slide thumbnail in the 

side panel and press Delete on your 

keyboard). On the remaining slides, 

you can highlight the placeholder text 

and replace with your own content; 

either by typing or copying and 

pasting.

Slide Layout Panel Figure 8A+B 

2.	Insert a new slide layout. To insert a 

new blank slide, with a layout of your 

choosing, go to the Ribbon > Home > 

Slides > and chose the New Slide icon. 

In the pop-up window you can choose 

from a multitude of slide layouts, 

including light and dark backgrounds. 

Click on your desired layout, and 

PowerPoint will insert a new formatted 

slide with text boxes and image frames 

ready to populate.

3.	Change the slide layout of an 

existing slide. If you would like to 

change your current slide layout, you 

can instantly change the layout by 

going to Ribbon > Home > Slides > 

Layout and clicking on the thumbnail 

of your preferred layout. This will 

automatically format your existing 

elements and content according to the 

new slide layout.

NOTE: If you choose a dramatically different 
layout, you may end up with unexpected results 
(such as unformatted text and floating content). 
This option works best for layouts that are similar 
in structure, and it can be very effective for certain 
updates, such as changing from a light to a dark 
background. If you are not satisfied with the result 
— just select your original layout from the slide 
layouts to revert to the previous layout, or choose 
undo (Mac: Command+Z ; PC: Control+Z).

4.	Resetting the layout to its defaults. 

If you feel you have made too many 

formatting changes to your slide; or 

find that you are not getting the results 

you want, it may be easier to restore 

the original layout setting for that 

slide and start again. Ensure that you 

have the proper slide selected and go 

to Ribbon > Home > Slides > Reset. 

You will see that the slide retains the 

content you have input, but will revert 

to the template’s original formatting 

for that layout.
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Working with text
Placeholder text included in the templates 

uses the font Arial in a variety of sizes, 

colours and weights, in accordance with 

the Brand Standards. This typeface is the 

only approved font for print and screen 

marketing collateral. You should not use 

any other fonts. 

There will be times when additional text 

boxes are needed for references, captions 

or highlights that might not have been 

foreseeable in the development of the 

templates. Here are the recommendations 

for inserting additional text boxes:

1.	To add additional text boxes not in 

the layout: do not use the text box 

tool to draw a new frame. Instead, find 

a text box sample in your presentation 

that has similarities to what you want 

and then copy it. If the text box is on 

the same slide, you can click on the 

frame and either Option and Drag 

(Mac) or Control and Drag (PC) to 

copy the frame. Or if the sample you 

want to copy is on a different slide 

than your destination slide, you can 

copy and paste the text box using the 

Command+C; Command+V on a Mac, 

or Control+C; Control+V function on a 

PC. Then you can make the necessary 

minor text adjustments to size, weight, 

or colour. 

2.	If you must insert a blank text box:  

adhere closely to the formatting that 

has been used in the template. The 

colour palette is limited to the Theme 

colours that appear automatically 

in the colour palette panel. Do not 

deviate from consistent use of the font 

(Arial) or the Theme colours (one or 

two pop colours plus grey, black and 

white).

http://www.mun.ca/marcomm/brand/standards
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Working with images
Photos, illustrations and graphics can 

add visual interest to your template. We 

encourage you to select appropriate, 

licensed and on-brand images when 

compiling your content for marketing 

materials. 

What makes a photo on-brand?
Many of these templates have examples 

of on-brand photos included as 

placeholders. These photos combine the 

dramatic use of lighting and colour, with 

unique surroundings. People and locations 

are captured from extreme angles and are 

cropped in unexpected ways. 

If you would like to see more samples of 

on-brand photography, you can review the 

most recent Brand Standards, President’s 

Report, Luminus magazine or contact the 

Division of Marketing & Communications. 

(See the section on On-brand Imagery or 

Appendix 5: Support)

We recommend that you also review the 

Web Gallery on mun.ca, to find thumbnail 

images that are appropriate. Once you 

have made your selections, you can 

request high-resolution versions from 

Marketing & Communications.

Inserting or changing a picture
Whether you are placing a new image into 

a PowerPoint presentation or exchanging 

an existing image in a template with your 

own on-brand photo, there are a few 

different ways to approach these tasks.

For Mac and PC Figure 9A+B 

1.	Insert image. In the Ribbon go to 

Insert > Picture and navigate to the 

picture file you want to insert. In the 

next section we will outline how to 

format this picture using the picture 

formatting palette.

2.	Replace image. Click on the 

placeholder image or photo you would 

like to change. Then right- or control 

cick to bring up the secondary menu. 

Select Change Picture from the Menu 

and navigate to your preferred image. 

This will replace the content of the 

photo without repositioning its frame 

or altering your layout.

Formatting a picture
You may need to make adjustments to 

your images or photos once they are have 

been placed into your selected template. 

PowerPoint offers a number of formatting 

options for your images. The formatting 

tools can be accessed in the same way as 

text tools.

For Mac and PC Figure10A+B 

1.	Format picture tab. With the picture 

selected, in the Ribbon go to Format 

(Mac: Picture or PC: Picture Tools) 

and explore the formatting options 

depicted by icons; including fills, lines, 

size, position, cropping and rotation 

options.

2.	Right- or control-click. Click on the 

image or photo you would like to 

format. Then right- or control-click to 

bring up the secondary menu. Select 

Format Picture from the Menu to 

launch a complete picture formatting 

window with all the formatting options 

available for that image.

http://www.mun.ca/marcomm/image/photogallery.php
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Rotate an image Figure11A+B 

From the picture formatting pane in the 

Ribbon, select the Rotation icon, and you 

can chose from a menu of pre-determined 

rotation options. To do a custom rotation, 

double-click on the image so that the 

corner nodes appear. At the top of the 

graphic you will see a small line with a 

green node on the end — this is called 

the Rotation Handle. If you hover your 

cursor over the green node you will see a 

rotation symbol appear. Click and move 

the mouse right or left to rotate your 

image accordingly. 

Crop an image Figure12A+B 

From the picture formatting pane in the 

Ribbon, select the Crop icon, and you can 

chose from a menu of pre-determined 

cropping and masking options. Practice 

with these tools to see what effect you 

can achieve. 

Resize an image Figure13A+B 

From the picture-formatting pane in the 

Ribbon, select the Size icon, and you can 

check the small box to ensure the image 

scales in proportion — without getting 

distorted. To do a manual scale, double-

click on the image so that the corner 

nodes appear. Click on one of the four 

corner nodes on the image and move 

the mouse to scale the image smaller or 

larger. If you select one of the nodes on 

the sides, top or bottom, you must hold 

Shift while scaling, to ensure that the 

image does not lose it proportions. 
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SHIFT

SHIFT

SHIFT

return  return  return 
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Creative Tips & Tricks
Here are some creative tips that will help 

you finesse your layout like a pro.

Typography 
Typography is the practical and artistic 

arrangement of type. It is important to 

understand that good typography is 

imperative to effective design. Proper 

type choices not only make for an 

esthetically-pleasing layout, but they also 

have a direct impact on how viewers read, 

interpret and engage with your message.

In fact, the better the typography, the 

less likely the audience is to notice it. But 

poor choices in type will definitely illicit a 

reaction — we have all had the experience 

of complaining about small type on menus 

or too much copy to read on a brochure.

Here are some typography basics:

DON’T put two spaces after a period. No 

exceptions.

DON’T use straight quotes or ticks marks 

— only use typographer’s (curly) quotes. 

DON’T stack letters vertically — like a 

motel sign. Type normally and then rotate 

the whole word instead.

DON’T distort type. Never stretch your 

type horizontally or vertically. Not ever.

DON’T outline type. Not ever.

DON’T ignore how headlines break. Lines 

of type should be broken to be both 

esthetically and logically pleasing.

DOn’t leave widows and orphans behind.

These are single words on the last line of a 

paragraph, or first line of a column, all by 

their lonesome.

Typographic examples 

no
th

ing

no
th

ing

adventured,

GAINED.

Wall art for arts building
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This sentence correctly 
has only one space at 
the end.Don’t use two 
spaces after a period, like 
this.Not ever.

This headline 
has line breaks 
that are balanced 
and pleasing.  

This 
headline does 
not have line 
breaks that 
are balanced 
and 
pleasing.  

"These" are not 
typographer’s quotation 
marks. Proper quotes are 
angled or “curly.”

M
O
T
E
L

M
O

T
E

L M
O

T
E

L

No distortion

Outlined Type

Never distort

Never distort

Never distort

Never distortEither of these 
is acceptable.

Notice how letterforms lose their shape and spacing.

Never 
acceptable.

Horizontal Scale @100% Vertical Scale @100%

Horizontal Scale @75% Vertical Scale @100%

Horizontal Scale @125% Vertical Scale @100%

Horizontal Scale @100% Vertical Scale @75%

Horizontal Scale @100% Vertical Scale @125%

{
{

{
{

{

A widow is a very short line – 
usually one word, or the end of a 
hyphenated word – at the end of 
a paragraph or column. A widow 
is considered poor typography 
because it leaves too much white 
space between paragraphs or 
at the bottom of a page. This 
interrupts the reader’s eye and 
diminishes readability. Fix them 
by reworking other line breaks or 
editing the copy. Can you see the 
widow?

A widow is a very 
short line – usually one 
word, or the end of a 
hyphenated word – at 
the end of a paragraph 
or column. A widow 
is considered poor 
typography because it 
leaves too much white 
space between paragraphs 
or at the bottom of a 
page. This interrupts 
the reader’s eye and 
diminishes readability. 
Fix them by reworking 
line breaks or editing the 
copy. So, where is  

the orphan?

Like a widow, an orphan 
is a single word, part 
of a word or very short 
line, except it appears 
at the beginning of a 
column or a page. This 
results in poor horizontal 
alignment at the top of 
the column or page. The 
term “orphan” is not 
as commonly used as 
“widow,” but the concept 
is the same, and so is the 
solution: fix it!
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Imagery
On-brand photos
Many of the templates have examples 

of on-brand photos included as 

placeholders. These photos combine the 

dramatic use of lighting and colour, with 

unique surroundings. People and locations 

are captured from extreme angles and 

cropped in unexpected ways. 

If you would like to see more samples of 

on-brand photography, you can review the 

most recent Brand Standards, President’s 

Report, Luminus magazine or contact the 

Division of Marketing & Communications. 

(See Appendix 5: Support)

Can I use clip art in my layout?
This is a quick one — NO. 

Never. Not ever.

If you want a professional layout, do 

not use the free clip art that is available 

online or bundled with Office products. 

But vector, graphic, line art or custom 

illustrations are acceptable (see samples 

provided). 

There are a wide variety of images that 

would be considered acceptable for 

inclusion in your layout. You should be 

looking for professionally-designed, 

polished and appropriate imagery 

whether it is computer-generated (vector), 

hand-drawn (line-art) or photography 

(raster). 

Imagery examples 
LUMINus, spring 2012 
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Colour and Contrast
There are 15 on-brand colour formulas 

used in the marketing templates and are 

labelled: red, orange, tangerine, yellow, 

lime yellow, green, teal, turquoise, sky 

blue, royal blue, pink, purple, charcoal, 

grey, black and claret. These colour 

swatches have been pre-determined 

as best-matches to our standard brand 

colours. We have developed more than 

30 different combinations of these colours 

to ensure a wide variety of options are 

available within Word and PowerPoint.

Please do not use any colours other than 

the selections available in the colour 

palette (one or two pop colours, plus 

white, grey and black).

To see colour equivalencies, see 

Appendix 2: Colour Nicknames & Colour 

Combinations.

One of the most important principles of 

design is contrast. Contrast occurs when 

two elements are different. The greater 

the difference — the greater the contrast. 

Contrast adds visual interest and helps the 

viewer organize content by importance. 

Elements that are large or bright are 

important, while elements that are smaller 

or lighter become secondary. 

Three common methods of creating 

contrast are by using differences in size, 

colour and type. This is how designers 

create visual and typographic hierarchy in 

layout and guide the viewer through the 

content in the order that was intended.

THe shininG, research report 2010
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Appendix 1 
Template Listing
Tri-fold Brochure

xx Four different designs 

Certificates
xx Thanks
xx Appreciation
xx Completion

Email Signature Templates
xx Standard
xx Short
xx Long

Newsletter
xx Multi-page format

Letter-sized Posters
xx  Six different designs 

Tabloid-sized Posters
xx Six different designs 

PowerPoint Presentations
xx Main; standard presentations 
xx Pop; bolder presentation

Program
xx Event program  

Screen Display Templates 
1024 x 728px 
1080 x 1920px 
1920 x 953px

xx Four different designs of each size

Appendix 2 
Colour Nicknames & 
Colour Combinations

COLOUR 
NICKNAMES  SPOT COLOUR

REFERENCE
COLOUR 

NICKNAMES  SPOT COLOUR
REFERENCE

COLOUR 
NICKNAMES  SPOT COLOUR

REFERENCE

RED  PMS 185 GREEN  PMS 368 PINK  RHODAMINE RED

ORANGE  PMS ORANGE 021 TEAL  3275 PURPLE  PMS PURPLE

TANGERINE  PMS 1235 TURQUOISE  PMS 3125 CHARCOAL  PMS COOL GREY 10

YELLOW  PMS YELLOW SKY BLUE  PMS 2727 GREY  PMS WARM GREY 6

LIME YELLOW  PMS 396 ROYAL BLUE  PMS 2736 BLACK  PMS BLACK

 

AaAa

Aa

Aa

Aa

Aa Aa

AaAa

AaAa

Aa AaAa

AaAa

Aa

Aa Aa

Aa

Aa

Aa Aa

Aa

AaAa

Aa Aa

Aa

Aa

Pink+White/Royal Bluered+White/yellow green+White/tangerine

orange+White/sky blue teal+White/yellow purple+White/lime yellow

tangerine+White/teal turquoise+White/lime yellow
charcoal

+lime yellow
gray+royal Blue

*claret+Whiteyellow+charcoal/turq sky blue+white/Tangerine

lime yellow+PINK/royal blue royal blue+white/red black+Pink

black+white

black+TURQUOISE
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Appendix 3 
Glossary of terms 
(reference: desktoppub.about.com)

Bleed When any image or element on a page 
touches the edge of the page and extends 
beyond the trim edge, leaving no margin.
It may bleed (extend off) one or more sides. 
Photos, rules (lines), colour and text elements 
can bleed off a page.

Body copy The main text found in 
publications we read — body copy — is 
the text of the stories and articles. Body 
copy does not include headlines, subheads, 
captions or pull-quotes.

CMYK Process colour or 4-colour process 
printing, uses cyan (blue), magenta (red), 
yellow, and black to simulate thousands 
possible colours. Colour profiles can be 
CMYK, RGB or spot colours.

Collateral Materials used to reinforce and 
develop a brand or campaign. For example, the 
range of materials for I ♥ MUNdays includes 
promotional items, print materials and online 
elements.

Crop To cut out or trim unneeded/unwanted 
portions of an image or a page is known as 
cropping. Cutting lines, known as crop marks, 
may be indicated on a print-out of the image 
or page to show where to crop. One basic way 
to modify images is to crop them — remove 
some part of the image. Cropping changes the 
appearance of photographs in order to better 
fit the layout, make a statement, or improve the 
overall appearance of the subject matter.

Dpi A measure of the resolution of a printer 
is called dpi, or dots per inch. It refers to the 
dots of ink or toner used by an imagesetter, 
laser printer or other output device to print 
your text and graphics. In general, the more 
dots, the better and sharper the image. 

Font The digital collection of all elements of 
a typeface that can be rendered in multiple 
styles, weights and sizes. A sample of the Arial 
font family is available on myfonts.com.

Headline Typically, they are short phrases 
or blocks of text that are often in display-sized 
type sizes (18 points and larger). Beyond what 
the headline says, it needs contrast — of size, 
weight, or colour to make it stand out.

Hierarchy The order of importance of 
graphic and/or textual elements on a page, 
hierarchy is conveyed visually, through 
variations in scale, colour, spacing, placement 
and other cues.

Letter-sized A common size for letters, 
newsletters and magazines (finished/folded 
size), copy machine paper and printing papers. 
In North America, letter-sized paper is 8.5 x 11 
inches. 

Masthead The graphic header or 
nameplate of a newsletter.

Orphan Commonly defined as the last line 
of a paragraph that is separated from the rest 
of the paragraph at the top of an adjoining 
column.

Palette (Colour) A distinct set of colours 
defined for use in a layout.

Palette (Menu) A common name for 
a window or panel that opens to reveal 
additional options in programs such as Word.

Pixelated Distortion in an image caused 
by printing a low resolution image on a high 
resolution printer. Also caused by scaling low 
quality images more than 100 per cent.

Placeholder Text or images used as stand-
in for final copy or photos.

PMS colour Pantone Matching System; a 
system of standardized spot colours that are 
used for colour management in offset press 
commercial printing. 

Ppi Pixels per inch, or ppi is a measure of 
the number of pixels displayed in an image. 
A digital image is composed of samples that 
your screen displays in pixels. The ppi is the 
display resolution not the image resolution.

PULL QUOTE Used to attract attention, 
especially in long articles, a pull-quote is a 
small selection of text pulled out and quoted 
in a larger typeface or using some other 
formatting distinct from the rest of the copy. 

Resolution The measure of quality for 
output on screen or paper. Measured in ppi 
for screen and dpi for printers.

Ribbon The control panel in Microsoft Office 
applications that appears at the top of the 
workspace. It contains panels and tools for 
layout, text, formatting and other options; 
typically organized into tabs.

Tabloid In North America, standard tabloid 
size paper is 11 x 17 inches.

Thumbnail A small picture or sketch that is 
representative of a larger full-size image.

Typeface The actual design of an entire 
set of letterforms of one weight including all 
numerals, glyphs and punctuation. A single 
typeface may be a part of a larger type family 
that may include additional weights and styles.

Typography The study of the design of 
letterforms and typefaces.

Widow Single word as last line of a 
paragraph that is considerably shorter than the 
other lines, and makes the paragraph appear 
off-balance.

http://desktoppub.about.com
http://www.myfonts.com/fonts/microsoft/arial/


29

before you begin

I don’t know where to start!

Are you a Mac or a PC?

What do you want to say?

How do you want to say it?

Don’t be a rule breaker!

So, what do we have here?

Microsoft Word templates

Microsoft PowerPoint templates

I need help with Word

Working with text

Working with images

How to save your document as a PDF

I need help with Powerpoint

Working with slide layouts

Working with text

Working with images

Creative Tips & Tricks

Typography

On-brand photos 
and imagery 

Colour and contrast

APPENDICES

Appendix 1: Templates listing 

Appendix 2: Colour nicknames & 
colour combinations

Appendix 3: Glossary of terms

Appendix 4: Resources

Appendix 5: Support

tips&tricks  
Marketing Templates

 PREV

Appendix 4 
Resources

Microsoft Office
Free training and video tutorials for all 
Microsoft Office applications (2007–2013) can 
be found online:

PC users:
office.microsoft.com/en-us/training-
FX101782702.aspx

Mac users:
www.microsoft.com/mac/how-to

2007 Microsoft Office Add-in: Microsoft Save 
as PDF (PC users):

www.microsoft.com/en-ca/download/details.
aspx?id=7

Brand & Marketing
Memorial Brand Standards
Memorial Style Guide
Other marketing resources

Appendix 5 
Support

Marketing & Communications
Brand & visual style
Memorial writing style
Template technical support
marcomm@mun.ca

Printing Services
Print-related queries
chafep@mun.ca

Computing & Communications 
helpdesk
Software & hardware queries
help@mun.ca

http://office.microsoft.com/en-us/training-FX101782702.aspx
http://office.microsoft.com/en-us/training-FX101782702.aspx
http://www.microsoft.com/mac/how-to
http://www.microsoft.com/en-ca/download/details.aspx%3Fid%3D7
http://www.microsoft.com/en-ca/download/details.aspx%3Fid%3D7
http://www.mun.ca/marcomm/brand/standards
http://www.mun.ca/marcomm/units/communications/style_guide/
http://www.mun.ca/resources
mailto:joycem%40mun.ca%20?subject=
mailto:marcomm%40mun.ca?subject=
mailto:chafep%40mun.ca?subject=
mailto:help%40mun.ca?subject=
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